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The Monitor 200 is a health and safety instrument that is optimized to detect low levels of radiation. It 
measures alpha, beta, gamma, and x-ray radiation (ionizing radiation only).

Its applications include:
• Detecting and measuring surface contamination
• Monitoring possible radiation exposure while working with radionuclides
• Screening for environmental contamination
• Detecting noble gases and other low energy radionuclides

How the Monitor 200 Detects Radiation
The Monitor 200 uses a Geiger-Mueller tube to detect radiation. The Geiger tube generates a pulse of 
electrical current each time radiation passes through the halogen quenched tube. Each pulse is electronically 
detected and registers as a count. The count is displayed in the mode you choose.

The number of counts detected by the Monitor 200 varies from moment to moment due to the random nature 
of radioactivity. A reading is expressed more accurately as an average over time, and the average is more 
accurate over a longer time period. See Chapter 3: Operating in Count Mode.

Precautions
To keep the Monitor 200 in good condition, handle it with care, and observe the following precautions:

• CAUTION: Never touch the Monitor 200 to a surface that may be contaminated. You may contaminate it.
• Do not leave the Monitor 200 in temperatures over 100° F (38° C) 

or in direct sunlight for extended periods of time.
• Do not get the Monitor 200 wet. Water can damage the circuitry and the mica surface of the Geiger tube.
• Do not put the Monitor 200 in a microwave oven. It cannot measure 

microwaves, and you may damage it or the oven.
• The Monitor 200 may be sensitive to and may not operate properly in radio 

frequency, microwave, electrostatic, and electromagnetic fields.
• The software may disconnect in high static conditions and may need to be restarted by the user.
• If you do not expect to use the Monitor 200 for longer than one month, remove the batteries to avoid 

damage from battery corrosion. A battery indicator appears on the display to show remaining power.
• The mica surface of the Geiger tube window is fragile. Be careful not to let anything penetrate the screen.
• This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and can 
radiate radio frequency energy, and if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause harmful interference 
to radio or television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following measures:

1. Reorient or relocate the receiving antenna
2. Increase the separation between the equipment and receiver
3. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected
4. Consult the dealer or an experienced radio/TV technician for help

Chapter 1: Introduction
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Chapter 2: Features
The Monitor 200 measures alpha, beta, gamma, and x-ray radiation. It is optimized to detect small changes in 
radiation levels and to have high sensitivity to many common radionuclides. This chapter briefly describes The 
Monitor 200’s features. The Monitor 200 counts ionizing events and displays the results on the liquid crystal 
display (LCD). The unit of measurement is located on the lower right, below the numerical value. The unit 
of measurement is selected by using the mode switch. Whenever the Monitor 200 is operating, the red LED 
indicator flashes each time a count (an ionizing event) is detected Figure 2(2).

The LCD Display
The LCD (liquid crystal display. Figure 2(1)) shows various indicators according to the mode setting, function(s) 
being performed, and battery condition as shown below.

Indicators

BATTERY ICON - Indicates that the Monitor 200 
is powered by the AA batteries and shows the 
remaining battery life. The battery icon (not shown) 
will not appear if it is plugged into USB power. 

USB ICON - Indicates that the Monitor 200 is plugged 
into the USB jack and is running on USB power. The USB 
icon will not appear if it is running on battery power.

BLUETOOTH ICON - Indicates that Bluetooth 
connection has been selected and is active.

ALARM ICON - Indicates that the alarm has been set and is active.

HOURGLASS ICON - Indicates that a timed count is being taken.

RADIATION ICON - The flashing radiation icon indicates that an alarm has been triggered 
and will remain until the radiation levels drop below the set alarm threshold. The radiation 
icon will continue to flash at the top of the display if an alarm has been muted.

BACKLIGHT ICON - Indicates that the backlight has been turned on.

AUDIO ICON - Indicates that the audio clicks will sound with each count collected.

MUTE ICON - Indicates the audio has been turned off and the Monitor 200 is operating in silent 
mode. While in silent mode, you will not hear the beeps that indicate turning on or off the alarm, 
turning on or off the timer or making changes in the menu. You can still activate the clicks by pressing 
the Audio button. The Mute function does not turn off the beeps from the Alarm or the Over Range 
feature. If you turn the unit off, you will have to turn the Mute feature back on if you wish to use it.

RECORD ICON - Indicates that the readings are being recorded into the internal 
memory, which can be downloaded with the free Observer USB Software. 
The record icon will flash when the on board memory is full.

Figure 2(1)
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The Buttons
The Monitor 200 has a circular membrane button 
on the face of the instrument, which consists of: 
Power (Enter), Alarm, Count, Audio (Minus), Menu, 
Backlight (Plus), and Mode.

Power (Enter) Button
The power (enter) button is located in the center 
of the membrane switch. It turns the Monitor 200  
on and off and acts as the “Enter” button when in 
the utility menu. To turn the Monitor 200 on, hold 
down the power button until you hear a beep. To 
turn the unit off, press and hold the power button 
until prompted to release.

Alarm Button
The alarm button is used to activate the alarm 
after setting the desired alarm levels.

Count Button
The count button is used to take a timed count. To 
enter the time set screen, press the count button. 

The default count time is 10 Minutes. See Chapter 3: How To Take A Timed Count.

Audio (Minus) Button
When not in the menu, the Audio Button will function to silence the audio clicks and switch between silent and 
audio operation. To switch between audio clicks and no audio clicks with each count collected, press the Audio 
Button. To switch between silent and audio operation, which mutes everything except the ALARM and OVER 
RANGE, press and hold the Audio Button for 3 seconds.

NOTE: When in the menu, the Audio Button will function as the “scroll down,” or “Minus Button,” for numbers 
and settings in the utility menu.

Menu Button
Pressing the MENU button will enter into the menu. See Chapter 3: Menu.

Backlight (Plus) Button
The LCD has a backlight that can be activated for the default 7 seconds by pressing the backlight button. 
Pressing and holding the backlight button for 3 seconds will turn the backlight on permanently. Once the 
backlight has been permanently activated, pressing and holding the backlight button for 3 seconds will turn off 
the backlight.

NOTE: When in the menu, the Audio Button will function as the “scroll up,” or “Plus Button,” for numbers and 
settings in the utility menu. 

Figure 2(2)
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Mode Button
The MODE BUTTON (Figure 2 (2)) is used to select from the available units of measurement.

• mR/hr (MilliRoentgen) - displays the radiation level from .001 to 200.
• CPS (Counts Per Second) - displays the radiation level from 0 to 3923.
• µSv/hr (MicroSievert) - displays the radiation level from .001 to 2000.
• Counts - displays the accumulated total of counts from 1 to 9,999 kcounts (9,999,000).
• CPM (Counts Per Minute) - displays the radiation level from 0 to 235,400.
• µR/hr (MicroRoentgen) - displays the radiation level from 1 to 9999. Once the levels 

exceed 9999 µR/hr, the unit of measure will change to mR/hr. Once the radiation levels 
go below 9999 µR/hr, the unit of measurement will revert back to µR/hr.

• NOTE: In CPM and Count modes, when numeric values exceed 9999, the unit of 
measurement will change from COUNTS to KCOUNTS (1000 Counts).

The Detector
The Monitor 200 uses a half-inch, thin window Geiger tube, 
commonly called a “hotdog tube.” The screen is called the 
window (Figure 2(3)). It allows alpha and low-energy beta and 
gamma radiation, which cannot get through the plastic case, 
to penetrate the mica surface of the tube. The small radiation 
symbol on the back label indicates the approximate center of the 
Geiger tube.

CAUTION: The mica surface of the Geiger tube is fragile. Be 
careful not to let anything penetrate the screen.

The USB Port
The USB Port (Figure 2 (2)) allows you to interface with a PC for use with the Observer USB Software. See 
Chapter 6: Observer USB Software.

Lanyard Loop
The lanyard loop is located on the bottom of the Monitor 200 and serves as a means to connect a lanyard. It 
also serves as the clip to lock the instrument into the stand. 

Xtreme Boot
The Xtreme Boot is great for protecting against drops and scratches. You will need to remove the boot to 
change the batteries.

CAUTION: Be sure you do not damage the mica end window on the end panel of the detector 
when removing the protective boot. 

Figure 2(3)

(1) Geiger-Mueller Window
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Chapter 3: Operation
Starting The Monitor 200
Before starting the Monitor 200, install 2 AA alkaline batteries in the battery compartment located in the lower 
rear of the enclosure. You will need to remove the protective boot to gain access. CAUTION: Be sure not to 
press on the window of the GM tube while removing the boot.

The power button is located in the center of the circular buttons on the front. To turn the Monitor 200 
on, press and hold the power button until you hear a beep. The Monitor 200 then begins a system check, 
displaying the serial number and firmware version. After the system check, the radiation level is displayed in 
the previously selected mode. Approximately 30 seconds after start up, a short beep indicates that enough 
information has been collected to ensure statistical accuracy. 

If you plan on using the data logging feature, please be sure to set the correct local time and date with the 
Observer USB Software prior to activating the data logging. See Chapter 6: Observer USB Software.

Units of Measurement
The Monitor 200 is designed for the use of conventional measurement units; counts per minute (CPM), 
microroentgens per hour (µR/hr), milliroentgens per hour (mR/hr), counts per second (CPS), microsieverts 
per hour (µSv/hr), and counts, which are used when taking a timed count. To switch between units, press the 
mode button.

Display Update
In the dose, rate, and count modes, the numeric display is updated every second.

Maximum level
When the maximum level for the current mode is reached, the Monitor 200 beeps for 3 seconds, pauses for 3 
seconds, and repeats. The numerical values displayed will show OVER instead of the specific rate. The beeping 
pattern and the flashing display continue until the level decreases or the instrument is turned off.

Response Time (Autoaveraging)
When the radiation level is less than 6,000 CPM, the reading in any of the dose rate modes is based on the 
radiation detected in the previous 30 seconds. In order to give a quicker response to changes, when the 
radiation level exceeds 6,000 CPM in any 30-second period, the reading is based on the previous 6 seconds. 
When the radiation level exceeds 12,000 CPM in any 30-second period, the reading is based on the previous 
3 seconds. NOTE: Though Auto Averaging is on by default, you can disable it to get a faster response time of 
3 seconds. In background conditions, the unit may show zero counts as there were no counts within the last 3 
second time period. This is normal when auto average is disabled. 

After 30 second start-up      The reading will be based 
if instrument is detecting    on an average of the previous
(<100 CPS)       30 seconds  
<6000 CPM or <1.75 mR/hr
(100 -200 CPS)      6 seconds
6000-12,000 CPM or 1.75-3.6 mR/hr
(>200 CPS)       3 seconds
>12.000 CPM > 3.6 mR/hr



8

Autoranging
When radiation levels increase in some modes over certain preset levels, the Monitor 200 uses autoranging, 
automatically changing from CPM to KCPM or from µR/hr to mR/hr. 

Operating in Dose/Rate Modes
Caution: Be sure there is no obstruction between the detector window and the source being monitored/
surveyed. Avoid making measurements with the GM window facing the sun, as it could affect your readings.

At low count rates, significant changes in the radiation level displayed can take up to 30 seconds to stabilize 
when set to auto-ranging. See Autoaveraging.

CPM, CPS, and Total counts are the most direct methods of measurement. 

µR/hr, mR/hr and µSv/hr are calculated using a conversion factor optimized for Cesium-137. This mode is 
less accurate for radionuclides other than Cs-137, unless you have calibrated the instrument for the specific 
radionuclide you are surveying.

The most immediate indicators of the radiation level are the audio indicator and count light.

Using The Alarm
The Alarm can be set in dose or rate modes using the currently selected unit of measurement. Once the alarm 
threshold is reached, the beeper will sound and the alert icon (radiation symbol) will flash until the alarm is 
deactivated, or the radiation level drops below the set alarm threshold.

1. To set the alarm, press the alarm button. The SET ALARM screen will be displayed. 
2. Use the + or - buttons to increase or decrease the desired alarm level. 
3. Once you have set the alarm to the desired level, press the enter button to retain the setting into 

memory and activate the alarm. The alarm icon (bell icon) is now displayed to indicate the alarm is active.
4. Once the alarm is triggered, press the alarm button to mute the alarm. The alert icon (radiation symbol) 

will remain flashing until the radiation level falls below the set alarm level.
5. To deactivate the alarm mode, press the alarm button, then the enter button. The alarm icon is no longer 

shown at the top of the display.

Using the Data Logging Feature
It is not necessary to set the internal clock to start collecting data to memory, but it is recommended to 
properly time stamp the data collection on your device to ensure the correct time and date in your collected 
readings. You will need a copy of the Observer USB Software to set the internal clock. The latest version is 
available at seintl.com/software. See Chapter 6: Observer USB Software. The internal clock of the Monitor 200 
can be set to the date and time on a PC running the Observer USB Software by clicking Functions > Synchronize 
Monitor 200 to PC Clock. The Monitor 200 will beep twice once synchronization has completed.

Once the time has been set, you can activate the data logging via the Observer USB Software or via the menu 
button on the Monitor 200. To activate it on the instrument, press Menu > Data Logging, then enter and 
follow the on screen prompts. The default data logging frequency is 1 minute. You can change the frequency 
in the Cal Panel window of the Observer USB Software. There is enough on-board memory for a data logging 
frequency of 1 minute to record for 90 hours. A data logging frequency of 10 minutes can record for 888 hours. 
See Chapter 6: Observer USB Software.
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Operating in Count Mode
A timed count is useful for determining the average counts per minute over a longer period of time. The 
number of counts detected varies from minute to minute due to the random nature of radioactivity. When a 
count is taken over a longer period, the average count per minute is more accurate.

Taking an average allows you to detect low-level contamination or differences in background radiation due 
to altitude or soil mineral content. For example, if one 10-minute average is 1 count per minute higher than 
another 10-minute average, the increase is likely due to normal variation. But over 12 hours, a 1 count per 
minute increase over the 12 hour background average may be statistically significant.

How to Take a Timed Count
1. Press the count button 
2. Using the menu button to switch between seconds, minutes, and hours, set the time using the + and - 

buttons, to increase and decrease the time. 
3. Once you set the count time, press the enter button (Figure 2(2)) to begin the timed count.
4. On the count screen, once the count has begun, a flashing hourglass will appear at the top of the display 

and a star will appear next to the count down until the count is completed. Once the count is completed 
the hour glass and star will disappear.

5. From the count screen, press the mode button to cycle through the various units of measure. If you want 
to see the remaining time in the count, continue cycling through the units of measure until you return to 
the count screen. If you have pressed the count button accidentally and do not wish to start a new timed 
count, press the count button again to exit the set count time screen and return to the units of measure.

6. To stop the current count, press the count button, and press enter. 

Using Dose/Rate Modes While The Timer is On
Dose/rate modes can be used while the timer is on. In any dose/rate mode, the hour glass indicator will 
continue to flash during a timed count. At the end of the timed period, the hour glass will remain solid, and the 
Monitor 200 will beep 3 times.

Menu
The Menu allows the user to change the default settings for several operating parameters. Once a setting is 
changed, it remains in effect unless it is changed through the Utility Menu, the USB Observer Software, or by 
restoring the default settings.

1. To activate the Menu, press the menu button. The display will show the menu options. 
2. Scroll through the menu by pushing the + or - buttons.
3. To select an option, push the enter button.
4. Use the + or - buttons to toggle between choices and press the enter button to select the new value. To 

adjust another menu option, repeat the above steps.
5. To exit the Utility Menu at any time, press the menu button again. Normal operation will continue.
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Menu Items
Auto Averaging
Turns auto averaging on or off. On by default.
Data Logging
Turns the internal memory on or off to record readings. Off by default.
Set To Defaults
Resets the Monitor 200 to the default factory settings. Doing this will not change the deadtime and 
sensitivity, the time and date, or the data collection frequency.
Bluetooth LE
Turns the Bluetooth on or off. Off by default.

Monitor 200 Factory Defaults
The factory default setting are:

Auto Average - On

Clicks - On

Audio Button silent mode - Off

Count Time - 10 minutes (600 seconds)

Alarm - Off - Default level - 1070 CPM (1.0 mR/hr, 1000 µR/hr, 10 µSv/hr, 17 CPS)

Data Logging Interval - 1 minute

When you access Set to Defaults in the Menu on the instrument, all of the above settings will be returned 
to the factory defaults, except Data Logging. The Data Logging Interval can only be changed through the 
software.

When you turn off the Monitor 200, any settings you have made will come back to their last state except the 
Audio Button silent function. To switch between silent and audio operation, which mutes everything except 
the ALARM and OVER RANGE, press and hold the Audio Button for 3 seconds.

Setting the Internal Clock
It is not necessary to set the internal clock to start collecting data to memory, but it is recommended to 
properly time stamp the data collection on your device to ensure the correct time and date in your collected 
readings. You will need a copy of the Observer USB Software to set the internal clock. The latest version is 
available at seintl.com/software. See Chapter 6: Observer USB Software.

Interfacing with an External Device
The USB jack on the right side provides an interface for use with the USB Observer Software. See Chapter 6 
Observer Software. The USB connection will not charge the batteries. 
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Chapter 4: Common Procedures
The following sections give instructions for several commonly-used procedures. With any procedure, the user 
must determine the suitability of the instrument or procedure for that application.

Establishing the Background Count
Normal background radiation levels vary at different locations, different times, even in different areas of 
the same room. To accurately interpret the readings you get, it is good to establish the normal background 
radiation count rate for each area you plan to monitor. You can do this by taking a timed count. See Chapter 3: 
How To Take A Timed Count.

A 10-minute average is moderately accurate. You can repeat it several times and compare the results to 
establish accuracy. To establish a more accurate average, take a 1 hour timed count. If you need to determine 
whether there is prior contamination, take averages in several locations, and compare the averages.

Environmental Area Monitoring
You can keep the Monitor 200 in dose/rate mode whenever you want to monitor the ambient radiation, and 
look at it from time to time to check for elevated readings. 

If you suspect an increase in ambient radiation, use the count mode and take a 5 or 10 minute count, and 
compare the average to your average background count. If you suspect an increase that is too small to detect 
with a short timed reading, you can take a longer count (for example 6, 12, or 24 hours).

Checking for Surface Contamination
To check a surface, hold the detector window close to the surface, and read the count rate (wait 30 seconds 
or until the reading has stabilized). Do not touch the unit to whatever you are checking to avoid contaminating 
the unit.

Saving Data from Observer Software and Onboard Memory
There are different options for saving data from the Observer Software. With the Observer software active, 
open the File menu. You will see Save Chart and Save Grid.  Clicking on either of those will save a file of the 
current status of your readings. The file will be saved as a TXT file which you can name and save on your 
desktop.  After saving the file, open EXCEL and open that file in EXCEL. Follow the EXCEL directions to put data 
on a spreadsheet. 

The instrument also has on-board memory capabilities. To use this option, you must first enable Data Logging. 
You can do this either through the MENU on the instrument, or through the Observer Software. Once enabled 
and you wish to download the data, connect to the Observer Software and click the Functions tab. Click the 
Retrieve Memory button. This will take a few moments, during this time the software will not be responding. 
Once the data has been fully retrieved a Save button will be available on the bottom of the page. The data will 
be stored as a TXT file and automatically put in your documents folder under Observer USB Data. Of course, 
you also have the option of saving it on your desktop to a folder of your choice. Again, following the same 
procedure as above, open EXCEL and input the data to a spreadsheet. 

Additional information on the Observer software can be found in Chapter 6
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The Monitor 200 requires regular calibration and careful handling to assure good measurements. Use the 
following guidelines to properly maintain the instrument.

Calibration
We recommend that the Monitor 200 be calibrated annually, or as often as your regulations require. The best 
way to calibrate the Monitor 200 is using a calibrated source at a calibration lab.

The reference standard by which the Monitor 200 is calibrated is Cesium-137. A certified calibration source 
should be used. To calibrate the Monitor 200 for another radionuclide, use a calibrated source for that 
radionuclide or the appropriate conversion factor referenced to Cs-137.

CAUTION: Errors can occur when using low level sources or background for calibrating. In the Calibration 
mode, the smallest increment which can be adjusted is .010.

If you would like more information about source calibrations, please contact us at 1.800.293.5759 or go to 
seintl.com/services.

General Maintenance Tips
1. Do not get the Monitor 200 wet.
2. Be sure to store the Monitor 200 in a location without direct sunlight, as sunlight can damage the end

window of the detector over time.
3. Be sure to store the Monitor 200 inside the carrying case when not in use.
4. If you are planning to store the Monitor 200 for a long time, remove the batteries to avoid battery

corrosion inside the battery compartment.
5. Do not place the Monitor 200 inside a microwave oven as it can damage the instrument and/or the

microwave. This instrument is for detecting ionizing radiation such as alpha, beta, gamma, and x-rays. It
will not detect non-ionizing radiation such as microwave and radio emissions.

6. Do not place any objects that may puncture the mica end window of the detector near the detector
window.

Chapter 5: Maintenance
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The Observer USB reads in Total Counts, CPM, µR/hr, mR/hr, CPS, µSv/hr, and has the ability to collect, log 
the data received, set the calibration date and settings, and echo the readings collected on a PC. The data 
is displayed on a graph, as well as a digital on-screen meter. Data can be saved or printed in various ways, 
including a spreadsheet format. The dwell/count time can be adjusted for each point on the graph. You can 
also set the length of time for the count. The software display has adjustable settings as well as a settable 
alarm.

Installing the Observer USB Software
The New Observer USB is a free version of the Observer software that runs on Windows®. You can download a 
copy the Observer USB Software at seintl.com/software. Install the software prior to connecting your Monitor 
200 to the computer. After the software has completed downloading, double click on the installer, and follow 
the on-screen prompts.

Connect to The Monitor 200
Once the software is installed and started, it will 
run as a service in the background identified by 
the icon in the system tray. The instrument will be 
automatically detected and identified when the 
Monitor 200 is connected via USB. The USB port is 
a micro USB jack located on the side of the Monitor 
200 Figure 2(2). To connect the Monitor 200, turn 
the instrument on, plug the cable into the USB jack, 
and connect the other end to the USB port on your 
computer.

Once the Monitor 200 is connected, the Observer 
Software will launch and open a window for the 
instrument with the serial number displayed in 
the upper left corner of the title bar (Figure 6(1)). A new window will open for each detector 
connected.

Observer USB Chart Screen
The Observer USB Chart Screen (Figure 6(2)) displays 
a chart of the data currently collected by the 
attached instrument.

The X Axis
The X axis consists of the time and date 
stamp of the reading collected and will adjust 
automatically to display all of the data collected 
unless the Scroll check box is selected. If the Scroll check box is selected, the X axis will 
display the latest readings collected in the minute(s) time frame selected next to the Scroll check box. For 
example, if 2 minutes is selected in the Scroll time, then the chart will display the latest 2 minutes of data 
collected. The most recent data collected will be shown on the right side of the graph.
The Y Axis
The Y axis displays the unit of measurement for the reading displayed and will automatically adjust to 
display the highest reading collected.

Chapter 6: Observer USB Software

Figure 6(1)

Figure 6(2)
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Observer USB Meter Screen
The Observer USB Meter Screen (Figure 6(3)) simulates a digital 
meter to display the readings collected by the detector.

Zero
When the Zero is clicked, the averaging of the collected 
counts starts over.
Averaging Time
The Averaging Time selects the amount of time in which 
the previous readings are averaged. The longer the 
averaging time, the more accurate your reading. Shorter 
averaging times allow significant changes to be seen more quickly.
Units
To switch between units of measurement, use the Units drop down menu. The Units drop down box 
selects the unit of measurement displayed on the y axis of the chart screen. You can select Averaging 
Time and the Units of measurement of the chart screen and the meter screen.
Echo Monitor 200 Display
When Echo Monitor 200 Display is checked, only the meter screen will mirror the display of the Monitor 
200.
Enable Alarm at and Latch Alarm
You must first check Use Audible Alarm in View > Preferences to enable the alarm on your computer’s 
sound system. The Enable Alarm at box will activate the alarm that is built into the software. Once the 
radiation levels go back below the set level of the alarm, the alarm will stop unless you have checked 
Latch Alarm. When Latch Alarm is checked, the alarm will continue to go off until the reset button is 
pressed. This is a USB Observer Software alarm only, not the alarm on the Monitor 200.

Show Grid
Show Grid displays an ongoing collection of 
data based on the user selectable settings in 
the View > Preferences > Grid Settings dialog 
box (Figure 6(4)).
Save Grid and Clear Grid
You can save or clear the Grid at any time by 
clicking on the Save Grid or Clear Grid boxes.

File
Save Chart
A text file of the Chart data is saved.
Save Grid
A text file of the Grid data is saved.
Exit
Closes the program.

Figure 6(3)

Figure 6(4)
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View
Preferences
Use View > Preferences menu to adjust the 
settings in the Observer USB Preferences  
(Figure 6(5)).

Chart Settings
Autosave and Clear Chart Every
Will automatically save and clear the chart at 
the number of minutes selected. Auto Save 
files are saved to the Observer USB Data 
folder located in the Documents Library.
Use Audible Alarm
Will sound an alarm on the computer’s 
sound system.

Grid Settings
Write to Grid Every 
Will set how often a new data point will appear on the grid.
Autosave and Clear Grid Every
Will automatically save and clear the grid at the number of data points selected. 
Additional Grid Data

Allows the setting of the units of measurement shown in the grid for Value 1 and Value 2.

Cal Panel (Calibration Panel)
Located under View > Cal Panel, the Calibration Panel Window (Figure 6(6)) displays the Serial Number and 
Calibration Values. You can use the Calibration Panel to change 
a number of settings on the instrument. The Monitor 200 
should be in a mode screen or count screen when choosing 
to Update Settings, as some changes to the menu items via 
the Cal Panel will not refresh if the instrument is displaying a 
menu screen. Note: Update Settings must be chosen before any 
changes made in the Calibration Panel will be applied to the 
Monitor 200.

Calibration Information
Calibrations, such as an NIST Source Calibration, contain 
information including the Serial Number, Calibration Date, 
Deadtime, and Sensitivity (cpm per mR/hr).

CAUTION: Please note that changes to the Serial Number, 
Calibration Date, Deadtime, and Sensitivity may void any 
calibration of the instrument on record.

Figure 6(5)

Figure 6(6)
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Alarm cpm and Alarm Enabled
To activate the alarm, enter the alarm threshold in the Alarm cpm field, and check Alarm Enabled. To 
disable the alarm, uncheck Alarm Enabled. If the alarm has been activated and Alarm Enabled is then 
unchecked, the alarm will continue to sound until Update Settings has been selected.
Preset Counting Time (sec)
Enter the number of seconds to set the time for taking a timed count. The default is 600 seconds.
Use Data logging
Enables writing the collected data to the internal memory. When the memory is full (Memory Full) will 
appear below Use Datalogging. Note: Set the time and date on the Monitor 200 before activating the 
data logging feature. The internal clock of the Monitor 200 can be set to the time on a PC running the 
Observer USB Software by clicking Functions > Synchronize Monitor 200 to PC Clock. The Monitor 200 will 
beep twice when synchronization has completed unless Quiet Mode is on.
Datalogging Interval (min)
Sets the interval for data logging. The default is 1 minute. This can only be changed through the software.
Circular Buffer
Allows the oldest collected data to be overwritten with the most recent data when the memory is full.
Clear Memory
Clears the data stored in the internal memory on the instrument.
Backlight On Time
Sets how many seconds the backlight will be on when pressing the backlight button.
Display Mode
Use to select from the available units of measurement
Contrast
Sets the contrast of the LCD display numbers and icons.
Auto-Averaging
This activates the auto-averaging feature. When unchecked, the Monitor 200 is in fast response mode. 
Fast response mode is only recommended for use in high radiation fields. 
Clicks Enabled
Enable or disable the clicks only. 
Quiet Mode
Enable or disable all sounds on the Monitor 200 except the ALARM and OVER RANGE. You can still enable 
clicks in Quiet Mode.

Functions
Retrieve Memory
If the recording feature is activated and the internal clock is set, then the collected data can be retrieved from 
the internal memory by selecting Functions > Retrieve Memory. Data is stored in a delimited text file, which 
can be opened in your preferred spreadsheet software. The default data logging frequency is 1 minute. You can 
change the value in the Calibration Panel window of the Observer USB Software.

Synchronize Monitor 200 to PC Clock
Sets the date and time on a PC running the Observer USB. The instrument will beep twice when 
synchronization has completed. 
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Chapter 7: Radiation Alert Observer Bluetooth BLE
To connect via Bluetooth

1. Download the Radiation Alert Observer BLE app from the Google App Store onto your phone or tablet.
2. Turn on your detector and activate the Bluetooth by pressing the menu button and using the up and 

down arrows to scroll to Bluetooth LE.
3. Press Enter and Use BluetoothLE? will appear. Press the + button to activate it or press the - button to 

turn it off.
4. The device will remain discoverable for 1 minute.
5. Make sure your phone or tablet's Bluetooth is turned on.
6. Launch the Radiation Alert Observer BLE.
7. Select Scan to begin searching for your detector.
8. The Model and Serial Number will appear in the list of available devices. Select your detector and you 

will be prompted to connect.
9. Select Yes and you will be taken to the Readings screen of the Observer BLE app.

Android device settings for Bluetooth can often be found by swiping down from the top of the screen to display 
a menu containing an icon for Bluetooth. Alternately, you can go to Home > Settings > Connections > Bluetooth. 
Once you are on the Bluetooth screen, be sure to turn on the Bluetooth radio and your phone or tablet will be 
ready for the Observer BLE App to search for available devices within range. If your device keeps loosing the 
Bluetooth connection, restart your device and reconnect.

Readings Screen
1. The Readings screen displays the readings from your detector at the top of the screen. The unit of 

measure shown will reflect whichever unit of measure is selected on the detector.
2. Below the readings are two text fields. The top one is the title of your Sample name. The lower text box 

is for notes and descriptions, as well as any GPS data you want to append to your survey.
3. Users can add any GPS data collected by their mobile device to the notes section of their survey by 

tapping the GPS button.
4. Note: If the GPS data is not available, the GPS data will be displayed 

as NO FIX. Depending on the settings of your device, you may need to 
allow the app to access the GPS data, as some settings will restrict the 
access to that data.

5. To quickly clear any of the text fields, select the X to the right of the 
corresponding text fields.

6. To save a survey, select Save. Users can append the current data to the 
existing text file on their device or to create a new one. Files will be 
saved to the ObserverBLE directory on their device.

7. To send your saved survey file, select the Send button. Users will then 
be prompted for the email address to which they want to send the 
survey data. The data will include a time and date stamp, the reading, 
the unit of measure used in the survey, the title of the survey, the 
notes from the survey and any appended GPS data.

8. ex: "05/01/2018","14:12:35","307150","8","uR/h","Title of 
Survey","Notes about the survey Lat = 35:28.62857 Lon = 
-87:19.84835" Figure 7(1)
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Timed Count Screen
The Timed Count Screen enables users to automate the process of 
collecting, saving, and sharing your collected Timed Counts. The units of 
measure displayed are raw counts.

1. Count Time (sec) - Select the time (in seconds) for your count.
2. Start – Your pad device will stay awake during the count. Total counts 

are the top of our screen.
3. To start a new count select Clear, set your time, and Start.
4. The top text field is the title of your timed count. The lower text box 

is for notes and descriptions, as well as any GPS data you want to 
append to your count.

Users can add any GPS data collected by their mobile device to the notes 
section of their count by selecting the GPS button. 

Note: If the GPS data is not available, the GPS data will be displayed as NO 
FIX. Depending on the settings of your device, you may need to allow the 
app to access the GPS data, as some settings will restrict the access to that 
data.

 To clear any of the text fields, select the X to the right of the corresponding text fields.

 To Save a Timed Count, select Save.... Users will be given the option to append the current timed count data 
to the existing file on their device or to create a new one. Files will be saved to the ObserverBLE directory on 
their device. 

To send your saved Timed Count file, select the Send... button. Users will then be prompted for the email 
address to which they want to send the Count Data file. The data will include a time and date stamp, the 
counts collected, the time of the count, the title of the Timed Count, the notes from the Timed Count, and any 
appended GPS data.

ex. “05/01/2018”,”14:39:51”,”307150”,”42”,”60 sec”,”Timed Count Title”,”Timed Count Notes Lat = 35:28.62716 
Lon = -87:19.84849”

Figure 7(2)
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Graphic Screen
The graphic screen is a graphical representation of the radiation levels 
detected.

1. The set up for the graphical screen is on the Settings screen.
2. Warnings are indicated by a change in the color wheel. 
•  Green – Okay
•  Yellow warning icon - Activates at 80% of the alarm level
•  Red – Alarm Level Reached 

 For example, if the alarm on your detector is set to 10 mR/hr, the warning 
will appear at 8 mR/hr. The warning alarm will remain active until the 
radiation level falls below the warning threshold or increases enough to 
trigger the alarm.

Once the alarm level is reached, the warning icon will change to a radiation 
symbol and the portion of the color wheel below the alarm set point will 
change to red. The alarm will remain active until the radiation level falls 
below the set alarm threshold on your detector.

Settings Screen
The Alarm level is set on the instrument or through the Observer Software.

The Settings Screen enables users to set the scale of the Graphic Screen and to add a phone number to send 
text alerts in the event that an alarm is triggered.

To set the scale of the Graphic Screen
1. Tap the three dots on the top right.
2. Select Settings…
3. Select the units of measurement at the top by tapping the box next to Select Units.
4. Select the scale maximum in the selected units of measurement by tapping the box next to Scale Max. 

The Scale Max is the unit of measurement that will determine the top end of the color wheel on the 
Graphic screen. For example, if the Scale Max is set to 10 mR/hr, then the color wheel will show a 
graphic representation of the readings collected up to 10 mR/hr. Users should be sure that the Scale 
Max is set to a value higher than the average background to see the full range available on the display. 
Additionally, the Scale Max should also be set equal to or higher than the alarm set on the detector.

5. To send text alerts when an alarm condition is triggered, tap the three dots, enter the phone number, 
and check the Send Text on Alarm box.

Rad Responder Screen
1. Tap the three menu dots on the top right.
2. Select Rad Responder...
3. To use this feature, you will need to sign up for a free Rad Responder account at radresponder.net.
4. Instructions for using the RadResponder App are on the website.

The RadResponder Network is the national standard and Whole Community solution for the management of 
radiological data. It is a product of collaboration between Federal Emergency Management Agency (FEMA), 
Department of Energy (DOE) / National Nuclear Security Administration (NNSA), and the Environmental 
Protection Agency (EPA), and is provided free of charge to all Federal, state, local, tribal, and territorial 
response organizations.

Figure 7(3)
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The Monitor 200 is a highly reliable instrument. If it does not seem to be working properly, look through the 
following chart to see if you can identify the problem.

Chapter 8: Troubleshooting

Problem Possible Cause Action

Display works, but no counts 
are registered

defective Geiger tube Look through the window to check the 
mica surface of the tube. If it is  
wrinkled or a break is visible, replace it.

Reading is high, but another 
instrument has a normal 
reading in the same location

possible contamination Scan the Monitor 200 with another 
instrument. 

Instrument has false high 
reading

moisture The circuit board may be wet. Dry the 
instrument in a warm, dry place. If 
it still has a problem, it may require 
service.

Instrument has false high 
reading or OVER RANGE

photosensitivity Remove the Monitor 200 from direct 
sunlight and ultraviolet sources. If the 
high count drops, the mica window 
coating may have washed off the 
Geiger tube due to getting wet. The 
tube will need to be replaced.

continuous discharge Replace the Geiger tube.

electromagnetic field Move the instrument away from 
possible sources of electromagnetic or 
radio frequency radiation.

Display is blank no battery, dead battery, poor  
battery connection, defective
LCD

Install new AA batteries. If count light 
and audio work, If the count light and 
audio work, it requires service.
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Xtreme Boot (Included)
The Xtreme boot offers maximum performance in a lightweight rugged 
solution for using Radiation Alert® products in the field. The Xtreme boot is 
designed specifically for individuals operating in tough environments, such as 
1st Responders and Mining and HAZMAT crews. Made of a RoHS compliant 
TPE rubber, the case also offers superior grip and drop protection.

Lanyard (Included)
The loop on the bottom of the enclosure can accommodate the included 
lanyard to help protect the Monitor 200 from drops. 

Stand (Included)
Whether you need to perform area monitoring or 
scan your hands and items for contamination, the 
STAND offers a convenient way for the instrument 
to stand vertically while leaving your hands free 
for other tasks.

Free Observer USB Software (Download)
The New Observer USB is a free version of the 
Observer software that runs on Windows®. It can 
be used with The USB versions of the Radiation 
Alert® Radiation Detector Family. The Observer 
USB reads in Counts, CPM, and CPS, as well as 
µR/hr, mR/hr, and µSv/hr and has the ability to 
collect, log, and perform statistical analysis on the 
data received. You can download a copy at  
seintl.com/software.

No Mac or WinRT versions are available. 

Accessories
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Detector
Halogen-quenched GM tube with thin mica end window. Mica window density 1.5-2.0 mg/cm2. 
Effective window diameter is .360 inch. Side wall is .012 inch thick.
Operating Range
mR/hr - .001 (1µR) to 200 mR/hr
µSv/hr - .01 to 2000
CPM - 0 to 235,400,  CPS - 0 to 3923
Total/ Timer - 1 to 9,999,000 counts
Humidity Range
10% to 70% Non-Condensing 
Accuracy (Referenced to Cs-137)
Typically ±15% from factory,  
±10% with NIST Source Calibration
Energy Sensitivity
1070 CPM/mR/hr referenced to Cs-137
Detects alpha down to 2.5 MeV; typical detection efficiency at 3.6 MeV is greater than 80%. Detects 
beta at 50 keV with typical 35% detection efficiency.
Detects beta at 150 keV with typical 75% detection efficiency.
Detects gamma and x-rays down to 10 keV typical through the window, 40 keV minimum through the 
case. Alert Set Range
mR/hr .001 - 100 and CPM 1 - 350,000
Internally mounted beeper, 70db @ 1m.
(Can be switched off for silent operation.)
Anti-Saturation
Meter will hold at OVER RANGE in fields as high as 100 times the maximum reading.
Averaging Periods
Display updates every second. At low background levels, the update is the average for the past 30-
second time period. The timed period for the average decreases as the radiation level increases. 
Display
Graphic Display with Backlight
Count Light
Red LED flashes with each radiation event
Audio Indicator
Internally mounted beeper (can be switched off for silent operation)
Outputs
USB and Bluetooth BLE (4.1) for use with Free Observer Family Software for PCs and Android OS. 
Power Requirements
Two AA alkaline batteries (included). Approximately 800 hrs at background.
Size
140 X 68 X 33 mm (5.5 X 2.7 X 1.3 in.)
Weight
182 g (6.4 oz)
Includes
Carrying Case, Xtreme Boot, Stand, Lanyard, Mini-USB Cable, Observer USB Software Download, 
Certificate of Conformance
Options
NIST Calibration
Limited Warranty - 1 year limited warranty

Appendix A: Technical Specifications
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WARRANTOR: S.E. International, Inc., P.O. Box 39, 436 Farm Road, Summertown, TN 38483-0039, USA, (931) 
964-3561

ELEMENTS OF WARRANTY: S.E. International, Inc., warrants for one year all materials and craftsmanship in this 
product to be free from all defects with only the limitations set out below.

WARRANTY DURATION: The warranty shall terminate and be of no further effect one year after the original 
date of purchase of the product or at the time the product is: a) damaged or not maintained as is reasonable 
or necessary, b) modified, c) repaired by someone other than the warrantor for a defect or malfunction 
covered by this Warranty, d) contaminated with radioactive materials, or e) used in a manner or purpose 
for which the instrument was not intended or contrary to S.E. International, Inc.’s written instructions. This 
warranty does not apply to any product subjected to corrosive elements, misuse, abuse, or neglect.

STATEMENT OF REMEDY: In the event that the product does not conform to the warranty at any time while this 
warranty is effective, the Warrantor will repair the defect and return the instrument to you prepaid, without 
charge for parts or labor.

NOTE: While the product will be remedied under this warranty without charge, this warranty does not cover or 
provide for the reimbursement or payment of incidental or consequential damages arising from the use of or 
the inability to use this product. The liability of the company arising out of the supplying of this instrument, or 
its use, whether on warranties or otherwise, shall not in any case exceed the cost of correcting defects in the 
instrument, and after the said one year period all such liability shall terminate. Any implied warranty is limited 
to the duration of the written warranty.

PROCEDURE FOR OBTAINING PERFORMANCE OF WARRANTY: In the event that the product does not conform 
to this warranty, please write or call to the address above. S.E. International, Inc. will not accept contaminated 
instruments for calibration or repair under warranty or otherwise.

NOTE: Before using this instrument, the user must determine the suitability of the product for his or her 
intended use.

Appendix B: Limited Warranty

IMPORTANT DISPOSAL INSTRUCTIONS:

As a responsible manufacturer we care about the environment. As such we urge you to 
follow the correct disposal procedure for your product and packaging materials. This will help 
conserve natural resources and insure it is recycled in a manner that protects health and the 
environment.

You must dispose of this product according to local laws and regulations. Because this product contains 
electronic components, the product must be disposed of separately from household waste when the product 
reaches its end of life.

Contact your local authority to learn about disposal and recycling.
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Or fill out the form online at 
http://seintl.com/calibration 

NAME MODEL NAME

COMPANY SERIAL NUMBER

ADDRESS

CITY

STATE, ZIP, & COUNTRY PHONE NUMBER

Please fill out this form and send it back to us if you would like to be 
notified of the NIST calibration renewal for your instrument to: 

S.E. International, Inc.
P.O. Box 39, 436 Farm Rd. Summertown, TN 38483

1.800.293.5759 | 1 931.964.3561 | Fax: 1.931.964.3564
www.seintl.com | radiationinfo@seintl.com

EMAIL

DATE PLACED IN SERVICE

Calibration Database Application




